
 

  

 
 

Fred Burrack, Ph.D. | Director 

Chris Urban | Assistant Director 

Assessment Dashboard in a Day 

Visualizing Assessment Data in Power BI 

 
 

 

 
 

assessment@ksu.edu 

ksu.edu/assessment 

 



Assessment Dashboard in a Day with Power BI 

  1 

This walkthrough demonstrates a process to create a basic assessment dashboard using Power BI.  

This guide should be considered a template showing key steps and functions that can be adapted 

for programmatic or institutional contexts. 
 

Part I: Create the Data Model 

Build the Fact Table 
 

1. Create a new report and get data 
 

Open Power BI Desktop and click Get Data 
 

 
 
 

 
 
Select Text/CSV, then click Connect. 

 
 
 
 
 

 
 
 
Choose the Scores Export Fall 2016 and Spring 2017 file and click Open. Then 
click Edit. 
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2. Use the Query Editor to Transform the Data 
 

Rename the Query to Fact Scores 

 

 

 

 

Remove unnecessary assessment id and attempt columns.  While 
holding Ctrl, click column headings to select columns for removal.  
Then right-click on a column heading and click Remove Columns. 

 

 

 
Because this is a fact table, we need to convert some columns into 
duplicated row values by Unpivoting Columns.  Select the columns 
to unpivot (all of the criteria columns) then right-click on a column 
and choose Unpivot Columns. 

 

 

 

 

 

Unpivoting converts these columns into rows. 
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Rename the unpivoted columns.  Double-Click the Attribute column 
and rename it to Criteria.  Rename the Value column to Score.  

 
 
 
 
 

Change the data type of the Score column to Whole Number.  Click 
on the icon next to the column header, then select Whole Number.   

 
 
 
 
 
 
3. Click Close & Apply to load the Fact Table to the data model 
 

 
 
 

 
FactScores will show up in the Fields pane.  Click the icon to view 
the FactScores table in the Relationships view. 
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Build the Dimension Tables 
 

1. Connect to additional source files.   

Click Edit Queries to return to the query editor.   

 

 

 

Click New Source, then select text/csv file and connect to the 
Student Demographics source file. 

 
 
 
 
 
 
 
 
 
 
 
Rename the query to DimStudent and click Close and Apply. 
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DimStudent will show up in the Fields pane and will connect to the 
FactScores table in the Relationships view. 
 
 
 
 
 
 
 
 
 
Repeat these steps to create DimCourse and DimTerm from the 
Courses and Terms source files.   
 
 
 
 
 
 
 

2. Create a table to define achievement levels associated with scores 
in FactScores.  Click Enter Data and type in the following to create 
DimScore. 
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3. Extract the list of outcomes.     

Right-Click FactScores & click Reference.  Rename the new table to 
DimOutcome. 

 

 

 

 

 

 

 

 

 

 
 

In DimOutcome, right-click the Criteria column to bring up the 

menu and choose Remove other columns.  Right-click Criteria again 

and choose Remove Duplicates.   

 

 

 

 

 

 

The table will now contain a single, unduplicated column of criteria. 
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4. Create Additional Fields 
 

Select the Criteria column.  In the Add Column tab, click Extract, 

then First Characters.  Extract the first 3 characters and rename the 

resulting column to Code. 

 

 

 

 

 

 

 

 

 

 

Select the Criteria Column. In the Add Column tab, click Extract, 

then Text Before Delimiter.  Enter a period (“.”) as the delimiter and 

click OK.   

 

 

 

 

 

 

 
 

Rename the resulting column to Outcome Letter.   
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Click the Outcome Letter column to select it.  In the Add Column 

tab, click Conditional Column.   

 

 

 

 

 
Enter Outcome Text as the new column name.  Then enter the 

fields as they appear below.   

 

 

 

 

 

 

 

 

 

 
 The Outcome Text column will appear in the table.   
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In the Add Column tab, cilck Merge Columns.  Choose a Custom 

Separator, enter a period (“.”), and type in Full Outcome Text as 

the new column name.   

 

 

 

 

 

 

 

 

 

 

 

 

5. In the Home Tab, Click Close & Apply to load the Dimensions to the 
Data Model  
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Confirm Data Model Relationships and Create Additional Key 

Fields 
 

1. Check that the Correct Fields are Connected.  Switch to the 
Relationships view.  Note the tables are not arranged in a star 
schema.  Move tables by clicking and dragging the table names. 
 
 
 
 
 
 
 
 
 

 
Click and drag from one field to another to create a relationship 

between DimOutcome[Criteria] and FactScores[Criteria].  
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Right-click on a relationship to delete it. Do this for the relationship 

between DimTerm and DimCourse.  

 
 
 
 
 
 
 
 
Double-click on a relationship edit it.  You can also use the Manage 

Relationships button to edit and create new relationships.  

 
 

 

Relationships must include a unique set (unduplicated) values on at 
least one side of the relationship.  They must be one-to-one or one-
to-many.  Try to create a relationship between 
FactScores[CourseID] and DimCourse[CourseID].  You should 
receive an error.   
 
 
 
 
 
 
 
This happens because CourseIDs are reused and there are multiple 
courses with the same ID.  We will create a new key field that 
combines CourseID and Term in order to connect these tables.  
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2. Create a new key field. 

Click Edit Queries to return to the query editor.   

 

 

 
In DimCourse, hold Ctrl and select course id then semester.  Then 
click Merge Columns in the Add Column tab.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Repeat these steps in FactScores to create the 
CourseIDSemesterKey field in that table.  Then click Close & Apply.   
 
Use the new key fields to create a relationship between FactScores 
and DimCourse. 
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The assessment dashboard data model is now complete and shows 
up as a star schema.   
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Part II: Create the Report 

Write DAX Measures to perform calculations and aggregate 

data. 
 

1. Create Count Scores Measure.   
 
Right-click on FactScores and click New Measure.   
 
 
 
 
 
 
The Measure editor appears at the top of the screen. 
 

  
 
Enter the following in the box to create count scores.  Then hit the 
Enter key.   
 
 
 
Repeat the previous steps to create the Count All Scores measure.  
Note that this measure references Count Scores.   
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Create additional measures: 
 

%Scores – Divides count scores and count all scores 
 
 
Count Students – Uses DISTINCTCOUNT to count individual students 

 

 

Count ALL Students – Total number of assessed students 

 

%Students – Use in charts that show % of students by demographics 
 

 

After creating each measure, click on the measure and set it to the 

correct options in the Modeling tab.  For example, %Scores should 

be set as a Percentage data type with 1 decimal place.  Its home 

table should be FactScores. 

 

 

 

 

Create the Visualizations 
 

1. Create Score Breakdown Chart 
 

Under FactScores in the Fields Pane, check the box for %Scores. 
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In Visualizations, click to change the visual to a Stacked bar chart.   
 
 
 
 
 
 
 
 
 
Add the Criteria and Score Text fields to the visual by dragging and 
dropping them into the field wells.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The resulting chart will show up on the report canvas.   
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To override the alphabetical sort order of the legend, click on Score 
Text in the Fields pane.  In the Modeling tab, set the Sort by 
Column to Score.   
 
 
 
 
 
 
 

 

 The legend will now be sorted by the score value instead of 
alphabetically. 

 

 

 

 

 

Set the Formatting Options for the chart using the Formatting 
Pane. 

 

 

Chang the data colors and turn the border and data labels on.   
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Change the title and legend text and format them.   

 

 

 

 

 

 

The resulting chart will look like this:  

 

 

 

 

 

 

 

Add Full Outcome Text above Criteria in the Axis field well to 
enable drilling up and down between levels. 
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The drill buttons now appear at the top of the visual.   

 

 

 

Drilling up and down displays data by criteria or outcome.   

 

 

 

 

 

Add Count Scores and Count All Scores to the Tooltips field well. 

 

 

 

 

 

Count Scores and Count All Scores will now appear in the tooltip 
when mousing over the visual. 
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2. Create Proficiency Rank Chart 
 

Click on the %Scores visual.  Use Ctrl+C and Ctrl+V to copy and paste 

the visual on the canvas.  In the new visual, replace Score Text with 

Proficient Status in the Legend field well.   

 

 

 

 

 

 

 

 

 

 
 

Use the Formatting Pane to change the Data colors and Title. 

 

 

 

 
 

In the Filters Pane, uncheck Not Proficient under the Proficient 

Status visual level filter.  This will cause the visual to show only 

Proficient scores.   

 

 

 

 

 

 

 



Assessment Dashboard in a Day with Power BI 

  21 

The resulting visual will look like this: 

 

 

 

 

 

 

Select the visual and click the Ellipsis (…) icon.  Then choose to sort 

by %Scores to sort lowest to highest.  You may need to click the AZ 

icon next to Sort By to sort the correct direction.   

 

 

 

 

 

 

 

 

 
 

3. Create Demographic Charts 
 

Click a blank spot on the canvas so that no chart is selected.  Then 

click the Donut Chart icon from the visualizations pane. 
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Add Current Major and % Students to the chart.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Change the Formatting Options and view the new chart. 
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Copy and paste the student chart.  Replace Current Major with 

Transfer in the Legend field well. 

 

 

 

 

 

 

 

 

 

 

 

Set the Formatting Options for the Transfer Chart.   
 

Add Count Students as a Card visual. 

 

 

 

 

 

 

 

4. Create Slicers 
 

Add Semester Title as a slicer visual.  Slicers are interactive and 

allow users to filter the data on the page.   
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Use the slicer menu to switch between options.  Display the 

semester slicer as a Dropdown. 

 

 

 

 

 

 

Some slicers work better when data is grouped.  For example, 

displaying every course may not be useful, but looking at <400 level 

courses and >400 level courses could provide some indication of 

differences between formative and summative assessments.   

 

Create groups using a calculated column.  In the data view, click the 

DimCourse table.   

 

 

 

 

 

In the Modeling tab, click New Column. 

 

 

 

 

 

Enter the following formula to check create a new column that 

shows whether a course is <400 (lower level) or 400+ (upper level).   
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The new column will appear.  In the report view, add this column as 

a slicer. 

 

 

 

 

 
 

Groups can also be created using the Groups option.  To create 

groups of lab and non-lab courses, right-click on Course Name in 

DimCourse and click New Group.   
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Create groups by selecting the courses you want to group and then 

clicking Group.  Rename the groups by double-clicking the group 

name.  Then click OK.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The group will appear as a new column in the table.   

 

 

 

 

 

 
 

Create a slicer from the new group. Copy and paste another slicer 

to carry over its formatting options.   
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5. Align and Distribute Elements.  As elements are added to the 
canvas, they may not be aligned appropriately.  These two slicers 
should be even top to bottom.  Instead of aligning these manually, 
use the built in formatting tools.   
 

 

 

 

 

 

Select the elements you want to align by holding Ctrl while clicking 

each element. In the Format tab, click Align, then choose an 

alignment.   

 

 

 

 

 

 

 

 

 
 

The slicers will now be aligned to the top.   

 

 

 
 

Use the Distribute tool to create even space in between three or 

more selected visuals, either vertically or horizontally.   
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Format the Report 
 

1. Add a Title.  On the home tab, click Text box.  Then type the title in 
the box and change the text format.   
 
 
 
 
 
 
 
 
 

 

 

2. Add a wordmark. 
 
Click Image.  Then select the image file.  Resize the image and place 
it in the correct location. 

 

 

 

 

Create a Page with Tables 

1. Rename the Page and Duplicate it. 
 
Double-click the page tab and type in a new name.   
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Right-click on the page tab and click Duplicate Page.  Rename the 
new page Tables.  
 
 
 
 
 

2. Delete the proficiency chart by clicking on it and hitting the 
Delete key.  Click on the score breakdown chart to select it.  
Change it to a Table visualization type.   

 
 

 

Change formatting options and fields as necessary to make the 

table look presentable.  The final table will look something like 

this: 
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Test and Finalize the Report 
 

1. Test the report. Test your entire report before and after publishing 
and sharing to ensure it functions correctly and that viewers can 
easily understand and navigate. 
 
Test and change how visuals interact with each other.  
 
By default, clicking one visual will filter all other visuals on the page.  
To disable this, first select a visual. Then click the Edit Interactions 
option in the Format Tab.   
 
 
 

 
 
 
Then use the icons at the top of another visual to change whether 
the interaction filters or does nothing to another visual.   
 
 
 

 

 

2. Verify data confidentiality.  View the additional resources 
document on ensuring confidentiality in Power BI. 

 

Update the report using new data 

1. Add the new data. 

Click Edit Queries to return to the query editor.   
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Click New Source, then select text/csv file and connect to the Fall 
2017 and Spring 2018 Scores Export 

 
 
 
 
 
 

 
 
 
 
 

Rename the query 2017-18 Scores Raw 
 
 
 
 
 
 
 

Right-click the query and unselect Enable Load.  This will prevent 
this raw data from loading to the data model.   
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2. Append the data to FactScores so that all the existing 
transformations are applied.   
 

Click FactScores.  In the query steps, click the Changed Type step.   
 
 
 
 
 
 
 
 

 

Click Append Queries.  Appending adds another table as new rows. 
 
 
 
 
Click Insert to clear the warning message. 
 
 
 
 
 
 
 

Select the 2017-18 Scores Raw Table and click OK.   
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3. Update the Terms source file to add a new term.  In the windows 
file explorer, navigate to the Terms source file and open it in Excel.   
 
 
 
 
 
 
 
Type in additional term information for Fall 2018. 
 
 
 
 
 
 
 
Save the file with its original name and location to maintain the 
connection in Power BI.   
 
In the Power BI Desktop Query Editor, select DimTerm.  Click 
Refresh Preview to see the new Fall 2018 row in the table.   
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Click Close and & Apply to load the new data to the report. 
 
 
 
 
 
If the table doesn’t update, manually refresh by right-clicking on the 
table and clicking Refresh Data.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 


